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Putting it all Together...

= X Board 25749
= Proteus X LE
= Ableton Live Lite 4 for E-MU

Introduction

This guide contains a basic walk-through of Ableton Live Lite 4 for E-MU and the E-MU
X Board. We encourage you to perform the steps on your computer as you read so that
you become familiar with the process.

Before you Begin:

¢ You should have already installed the E-MU X Board and software on your computer
according to the instructions in your printed “Getting Started” manual.

¢ You should have already installed the Ableton Live Lite 4 for E-MU software on your
computer according to the instructions provided with the Ableton software.

* You should hear sounds from Ableton Live Lite 4 for E-MU when you play the
Ableton demo.

Ableton Live Lite 4 for E-MU

Ableton Live Lite 4 is an innovative composition and performance tool. Ableton Live
combines digital recording, virtual instruments, digital effects with an original interface
design that many people find more intuitive than traditional designs.

The following step by step tutorials are designed to get you recording as quickly as
possible. After you have finished the tutorial we encourage you to follow Ableton Live's
excellent interactive Lessons and read the Ableton Live reference manual pdf in order to
learn more about the program.

1 - Setting up the Preferences

Follow the Preference Setup instructions provided with Ableton Live Lite 4 for E-MU.
(Options menu, Preferences) Play the Ableton demo to make sure the audio path is
correctly configured before continuing. Ableton will remember these settings, so you'll
only have to do this once.

Set up the Plug-ins
The following steps allow Ableton Live Lite 4 to find the VST Plug-ins and Proteus X LE
VST.

1. Click on the Plug-ins tab of the Preferences dialog box under the Options menu.
The following screen appears.

Creative Professional
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Locate: Steinberg\VSTplugins

2. Press the Browse button, then locate VST Plugins located in the Steinberg folder.

3. After selecting the VST plug-ins folder, press OK. (You may have to wait a few
seconds while Ableton locates the plug-ins.)

Set up the MIDI Parameters

4. Click on the MIDI/Sync tab of the Preferences dialog box. The MIDI screen appears.

i Live enables every
MIDI input by default

[ [E-DSP wiDI Port [FOCO |
. N
e Select E-MU
MIDI-USB if
you have an
E-MU X Board
connected.

5. Select E-MU-USB Device to connect the E-MU X Board.
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2 - Running Proteus X LE VSTi from Ableton Live

These instructions explain how to run Proteus X LE from within Ableton Live Lite 4.
Ableton Live's forte is making it easy to combine pre-recorded audio and MIDI clips in
new and exciting ways. In this tutorial, you'll learn how to use a MIDI keyboard or the
excellent pre-recorded MIDI loops that come with Ableton Live Lite 4 to play

Proteus X LE.

Select the Virtual Instrument

1. If you began with Tutorial 1- Setting up the Preferences, you should have a new set
open with two audio tracks and two MIDI tracks such as the one shown below. (If
you have another set open select New Live Set (Ctrl+N) from the File menu.)

3. Drop Here
\Buntitted - Live BT %
File Edit Insert Wiew Options Help
TR
1. Click £ Barx ~ » -
Hee WISET g7 = s
open  [EEMES W | = s
Plug-ins = &
TR
2. Drag A ProtousXLE Sends
Proteus X LE T SEX Machine LT Q

—
Y

~EEED| O

o
i

Drop MIDI Effects, Audio Effects or Instruments Here

2. Click on the Plug-in Device Browser button o on the left side of the window. =
The list of Ableton Plug-ins appears at the left side of the window.

3. Select Proteus X LE from the Plug-ins list and drag it over the MIDI Track heading
as shown above. Wait a second or two, then you'll see the Proteus X LE VSTi appear
in the MIDI Track View area below the mixer.

Load the Proteus X LE Bank @ @ ProteusXLE

4. Click on the wrench icon @ on Proteus X LE in the MIDI es
Track View area.

= These instructions also
apply to Proteus X or
Emulator X.

O gF) Machine LT

R vb
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5. The Proteus X LE editor screen shown below appears.

ProteusXLE,-"3 -MIDI X,

Im-e.-»|,jf’“n|.1

Proteus X LE
{Untitled.exb)

#-_] Presets | PRESET (v |(a) - CHANNEL (w13 |
[#-_] Multisetups = T

<None>

CATEGORY

VOLUME

OUTPUT
Buz 1

IIIIIIIHIHI!.‘IIIIIIHIIIIIHIIIII!IIHIIIIIHI

For Help, press F1 |D bytes  |CPL |D|sk |Ch 1 |Prateus ¥ LE "

mam S anpler o

Load the Proteus X Composer Bank

6.
7.

Proteus X LE is now running, but you need to load a bank of sounds.

Choose Open from the File menu on Proteus X LE. Locate and load the Proteus X
Composer bank, which is located here: (“Program Files/Creative Professional/E-MU
Sound Central”) The bank takes a few seconds to load.

Play the Proteus X Composer Bank

8. Click on the mini keyboard at the bottom of the window. You should be hearing
sound. If not, close Ableton Live Lite 4, and verify that you have the PatchMix DSP
Product Default session loaded. Then close and restart Ableton Live Lite 4. Try out
the X Board 25/49 keyboard and controller knobs.
@ ® @ Factory Content
9. Change the Preset using the preset inc/dec keys. [EEERaID) PR
10. Feel free to play around for awhile—turn some knobs, change presets. Don’t worry = oo Seun
about losing anything. Nothing is made permanent until you Save the bank. B 1-Make Music with Live.als
’ [B)] 2-Editing Arrangemants.als
11. When you're ready to move on, select preset, P0004 A KuStq , then close the Proteus B 3-MIDI instruments Frals
X LE editor by clicking on the close box 3. [B_4-Groating Patiorns.aie
[B)] s5-Record and Automate.als
. B &-Mix and Remix.als
Play MIDI C“pS [B] 7-Hands-On Control.als
12. Locate MIDI Loops by Keyfax in the Factory Content section of the Ableton Live : m::,:“m
Lite 4 Browser. =
13. Click on the folder to open it. You'll see a bunch of other folders.

Putting it all Together - X Board, Proteus X LE, Ableton Live Lite 4 for E-MU 9
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14. The first folder, BRK_120 contains a nice bass riff. Open it, then open the next
folder BRK-Bass.mid . Now, you'll see a MIDI file named BRK-Bass.

15. Click and drag BRK-Bass over one of the clip slots in the 3 MIDI strip as shown

below.
Stlop
& Untitled - Live Lite 4 for E-MU l g@|
File Edit Insert ‘iew Options Help

Show/Hide In/Out Section

16. Now click on the Clip Launch Button (little triangle) =+ on the MIDI clip you just
dragged over. The MIDI bass loop begins playing the bass preset on Proteus X LE. To
stop playing, press the Stop button.

17. Find some other MIDI loops and drop them into the other slots of the track. Hint:
look in different folders. Click on the Clip Launch Buttons to switch between clips.
Add Another MIDI Track

Ableton Live Lite 4 allows four MIDI tracks, so let’s play a different MIDI loop and
sound on track 4 MIDI.

18. Choose a different MIDI loop such as House-Lead, (located in the HOUSE-120
folder) and drop it onto one of the 4 MIDI clip slots.

19. Click on the Show/Hide In/Out Section button & shown above. The Input/Output
options now appear in the track strips.

20. Currently, the MIDI To box reads “No Output”. Instead, select 3-MIDI . Another
option box labeled “Track In” now appears beneath 3-MIDI.

I

O 20 16

£
|

Al Ins

§ Al Chann w|
Maonitor

Auto

MID =|| ¢— Select

=][«] &
] =]
=5|=
= =]
4

3-MIDI

> [ollzlt
LIIIIT111]1])]
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21. Click on the Track In box to see the list of MIDI channels.
22. Select MIDI Channel 2 as shown at right.

23. Click on the Clip Launch Button » on the 4 MIDI clip to get it started. You won't
hear anything because you haven't yet assigned a preset to MIDI channel 2 on
Proteus X LE.

Choose a Sound for MIDI Channel 2

24. Click on the 3 MIDI heading to show the Proteus X LE VSTi. Next, click on the
wrench icon @ again (in the MIDI Track View) to open Proteus X LE.

25. Select MIDI Channel 2 using the channel inc/dec keys |EETEI0N

26. Select a Preset on Channel 2. Place the cursor in the preset number field and use
the up/down arrow keys on your computer keyboard to scroll through the list.

e Note: There are several ways to select presets. See the Proteus X LE Operation
manual for details.

27. Now you should be hearing the beat. If not, check to make sure both clips are
playing (green triangle). Each clip plays a different preset.

Add MIDI Clips

28. Drop a few more MIDI clips into both MIDI channel slots. Play around with the
Clip Launch buttons.

Preset Change

Here's another way to change the MIDI Program (Preset in E-MU speak) without going
into the Proteus X LE editor.

29. Double-click on one of the currently playing MIDI clips. The Clip View appears at
the bottom of the window.

30. Select the Show/Hide Notes Box located in the lower left corner of the
Clip View window. The Notes box appears in the Clip View section. =
31. Select a Program number. You'll hear the Proteus X LE sound change. Keep
selecting until you find one you like.
e Hint: Use the Up/Down Arrow Kkeys to select Programs. Use Sub-Bank to select
presets higher than 128.

32. As an added bonus, the program (sound) you selected is now associated with the
MIDI clip. Whenever you select this MIDI clip, the sound will also be selected.

33. Select another clip and assign a different program number. Notice that the Preset
changes when you switch back and forth between clips.

Save the Set

34. Save your work by selecting Save Live Set As... from the File menu. The next time
you load the set, the Proteus X LE bank will automatically load as well.

Setup to Record a MIDI Track

Now let’s record a MIDI track using the E-MU X Board. If the X Board isn’t already
connected, you'll have to quit Ableton Live Lite 4, connect the X Board, then restart
Ableton Live Lite 4 before continuing.

35. You can use the MIDI Track you set up on MIDI channel 2. Make sure there is at
least one empty slot in the MIDI track. (Select and hit backspace to delete a clip.)

MIDI To
3-MID L

Track In -

Track In

1-ProteusxLE
2-ProteusXLE
F-ProteusxLE
4-Proleusx LE
S-ProleusxLE
G-ProteusX LE
T-ProteusXLE
B-ProteusXLE
S-ProteusXLE
10-ProteusXLE
11-ProteusXLE
12-ProteusXLE
13-ProteusXLE
14-ProteusXLE
15-ProteusXLE
16-ProteusXLE

i Proteus X LE sounds
are called Presets or
Programs. Ableton Live
Programs are offset by +1
from Proteus X LE.

:
O

Orig. BPM
®
G @[ [ ][ 1]
Bank End ®

[l AL 1]
[l d g
e ~|f[ of of of

P‘rpgr“ Offset .
Non
|
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36. Click on the Show/Hide In/Out Section button & if it's not already selected.
The Input/Output options now appear in the track strips.

37. Set up the MIDI track as shown at right.

Select the X Board in “MIDI from”.

Set the input to listen to MIDI channel 2.

Monitor should be On (for now).

This routes the MIDI data to track 3 (which contains Proteus X LE).

Set the output to MIDI channel 2.

Turn record On (red).

me AN T

38. Set your X Board to transmit on MIDI channel 2 .
(Press the MIDI Channel button, select Channel 2, then press Enter.)

39. Play the keyboard. You should hear Proteus X LE playing the last sound you
selected on channel 2. Go ahead and change the sound if you wish. (Double-click
the top of Track 3, then click the Wrench icon on the Device Title Bar. Make sure
you're changing the sound on channel 2.)

Ready to Record

40. Start up the bass line on track 3 MIDI and practice playing along with it.

41. Optional: You can set the Global Quantization value to time correct your playing.
Set it to anything other than “None”.

42. Click on any of the MIDI Clip Record buttons to begin recording. e |

43. Click the Clip Launch button, the Clip Stop button, or the Spacebar to stop
recording.

On Your Own

Now you've had a taste of what Proteus X LE and Ableton Live Lite 4 can do. But don't
stop now! Read the Proteus X LE Operation Manual pdf to learn all about this excep-
tional instrument.

Ableton Live Lite 4 for E-MU includes several excellent hands-on tutorials to help you
learn all the features of this ground breaking music application.

Note: The “Assignable X-Y Controls” are not enabled in this version of Proteus X LE.

—E-MU

4 MIDI

MIDI From
fCh 2 =
Maonitor

MIDI To
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